
Microangelo™  GIFted Quickstart User Guide

Microangelo GIFted was designed to provide a powerful set of drawing and editing tools for GIF 
animations.  It also includes GIF file optimization algorithms that were engineered so users can fully 
concentrate on their animation, freed from the burdens of selecting image disposal methods and 
frame-by-frame cropping of update areas.  These tasks, until now, have taken away some of the 
enjoyment found in creating animated GIFs.

Let's Get Started!

This document is divided into three sections.  The first section is a brief introduction to using GIFted.  
The second and third sections contain information on color palettes and the files size and 
performance optimizations of animated GIF files.  The information in sections two and three is also 
included in GIFted's online Help.  This information will help users create better animations with less 
work and enjoy the program to its fullest.

Section #1: Quick-start Introduction

Microangelo GIFted is unique in two significant ways:

(1)  GIFted provides drawing and editing tools for full-frame editing of every frame in an animation as 
they would appear if created for a movie on film.

(2)  GIFted provides incredible file optimization automatically.  Let's face it.  Optimizing GIF 
animations is a boring, tedious, painful process.  The kind of work that you bought your computer to 
do for you!  GIFted makes it so.  Tests performed at Impact Software showed that GIFted improved 
the optimization of almost every animation we could find - just by choosing Save.Optimized and 
letting GIFted do the work!

Using GIFted
GIFted's online Help includes an excellent tutorial to help you get acquainted with creating an 
animation.  The following information will help you become familiar with the program before you 
begin.

Main Menu
Many menu items should be familiar to Windows users.  The file menu includes a Properties 
selection used to set the loop count of an animation, insert a comment, and view general information.

Upper Toolbar
Mostly standard buttons (New, Open, Save..).  The last two buttons on the right are used to add and 
delete frames from an animation.

When more than one frame exists, two additional controls are displayed at the far right of the bar.  
The first is an edit control used to set the desired time a frame is displayed in hundredths of a 
second.  The second is a drop down control used to choose the current frame to edit.  Clicking once 
in the frame selection control (not on the arrow button) allows easy "flipping" between frames using 
the arrow keys on the keyboard.

Lower Toolbar
Tool buttons on the left are used to nudge pixels left, right, up or down, or to flip (mirror) images right-
to-left or top-to-bottom.



Two controls centered over the editing grid provide zoom access.  The first control drops down to 
select a zoom level, the second is an on/off toggle that will switch between the zoom selection and 
actual size.

The right side of the bar includes four buttons to control painting of pixels by drawing tools as well as 
the current selections for Color A and Color B.  The Color A and Color B selections are very 
important - they indicate which colors are currently selected for use by the drawing tools.  The 
buttons directs tools to paint all pixels, or to confine their painting to "every other" pixel.

Drawing Tools
The left edge of the main program window contains tool buttons used to select a drawing tool.  Tools 
are available for drawing pixels, lines, rectangles, ellipses, as well as specialty tools used for creating
text, locating colors, erasing by color, and selecting cut, copy and paste areas.  Place the mouse 
cursor over any tool for a moment for a tool tip to identify the tool and the tool's function to be 
displayed in the status bar.

Editing Grid
The editing grid is where all drawing and editing of images takes place.  A visible grid can be 
displayed, if desired, by selecting the Grid option on the View menu.  The visible grid will only display
when the zoom level is set to six or higher.

Palette Window
The Palette window can be displayed or hidden from the View menu.  This window displays ink wells 
for 256 different colors, the most allowed in a GIF image.  Click on any ink well with the left mouse 
button to select a new Color A, or with the right mouse button to select a new Color B.  Double-click 
on any well to change the color of ink it contains.

Preview Window
This window, also displayed or hidden from the View menu, displays the current frame being edited.  
When the "play" button is pushed on the Preview window, the animation is played instead.  You can 
edit images in the editing grid while the animation is playing.  The slider control is used to change the
overall speed of the animation - move left to slow and right to increase the rate at which the 
animation plays.

Section #2: Colors and Color Palettes

The tables that contain the actual red, green, and blue intensities of colors used in computer 
graphics are often referred to as palettes.  Microangelo GIFted displays the current color table in its 
Palette window in 256 different ink wells of colors that can be used to paint and draw with.

Colors and color palettes play a significant role in the development of an animated GIF.  Selecting a 
palette of colors that is most appropriate for your work BEFORE you begin developing an animation 
is crucial to both the quality of your results and the level of effort you will expend editing new colors.  
GIFted allows several options that you can use to initialize the palette of colors for an animation.  
These are described below in, "Initializing the Color Palette".

To develop high-quality animations, it's important to understand a few limitations that are imposed on
the use of color by the Graphics Interchange Format (GIF) file specification and also by GIFted itself.



The GIF specification allows for a maximum of 256 colors to appear within any single image.  It 
allows one of the 256 color entries to be designated as being "transparent".  Greater color depths, 
often referred to as "high color" or "true color", are not possible within a GIF image.

The GIF specification allows a file that contains multiple images (such as a GIF animation) to contain 
more than one color palette.  The first color palette that appears in the file is the global palette.  The 
colors defined in the global palette are used for every image in the GIF file.  The exception to this is 
called a local palette.  Any image in a GIF file may be preceded by a color table of its own.  This color
palette overrides the global palette and is used only for the frame that immediately follows.

Going Global
Microangelo GIFted is not designed to incorporate multiple color palettes within GIF animations.  For 
this reason, GIFted will not edit animations that contain local color palettes.  Animations produced by 
GIFted are limited to a maximum of 256 different colors.

One of the primary goals of GIFted is to produce animations that provide maximum performance, 
optimized update areas and reduced file sizes.  Local color palettes are in direct conflict with 
maximized performance and reduced file size.  A significant and somewhat related goal of GIFted is 
to provide painting tools to allow animations to be created within the program itself.  In most 
instances, 256 colors provides an adequate availability of color for this purpose.

Animations that require multiple color palettes are often composed of imported photos or graphics.  
In these instances we recommend using the graphics utility of your choice together with a GIF 
engineering tool such as Microsoft® GIF Animator.

In most cases, we recommend that you reserve one of these entries to be defined as transparent, 
even when an animation does not use transparency.  The reason for this is because GIFted can 
achieve higher levels of compression between frames of the animation when allowed to substitute 
transparent color values across areas of the update area that do not change between frames.  The 
exception to this, when it isn't important to reserve a color entry for transparent, is when the pixels in 
the animation always change color between each frame.  An example of this would be the 
presentation of still image "photos" that contain various different color patterns by nature.

Browsers and Color Palettes
It is important to be aware that other users' software and hardware may cause your animation to 
appear differently to them than as you designed it.  Some computer video displays are limited to 256 
colors.  Some video display drivers are limited to 256 colors.  If either of these cases is true, the 
software that is displaying the animation (perhaps a web browser) will be limited to 256 colors.  It will 
not be possible to provide the animation with all 256 specific colors that it desires.

Complicating matters further, if a computer's hardware or software does not allow it to achieve full 
24-bit color depth (8 pixels each for red, green and blue), it will probably not be able to display the 
exact RGB values that are defined in an image's color table.

Due to anomalies like these, an overwhelming majority of browsers always include a standard 236 
colors in their active color palette.  These color values are often referred to as the "non-dithering" 
browser color values because they are guaranteed to be available across all popular hardware and 
software platforms.  This means that the software will never attempt to translate an area of an 
unavailable color into patterns of two or more different colors to approximate the original.  When you 



use non-dithering color values you can be assured that the image will appear to everyone else 
exactly as it was designed.

How significant these factors are to your animations depend on several criteria.  Who will be your 
audience?  If you are developing a web site to attract as wide an audience as possible, then the non-
dithering color values may play a significant role in your artwork.  

Another item you may want to consider is that almost all new hardware and software are able to 
support high color depths very well.  If you're creating web content for a clip art retailer on the 
Internet, you may be able to depend on your audience's ability to display good color depth.

The Non-dithering Color Palette
GIFted includes a color palette that contains all 236 non-dithering colors organized by color hue and 
intensity.  Some colors such as pure red, blue, cyan, and others are duplicated along with the four 
non-dithering grays at the end of the palette for easy access.  The colors in this palette file are 
always available on all hardware and software platforms capable of displaying at least 256 colors. 

Initializing the Color Palette
Always initialize the color palette with an available array of colors most appropriate for your work 
whenever you begin a new animation.  GIFted initializes the color palette to the default palette file 
(stored in "muagif.pal") whenever the program starts and when a new file is opened.  You can 
initialize the palette to a different set of colors from another palette (*.pal) file, or from a GIF or bitmap
image on your computer.  Select the Palette.Open command and choose Palette or Image in the file 
type to locate the source you want to use.

If you plan on importing an image into your animation that you want to appear in the highest possible
quality, you may want to consider initializing the palette using the image file you will be importing.  
However if you plan to create the animation with the drawing tools within GIFted, choosing the 
Balanced or Non-dithering palettes provided with GIFted may be good choices.

Editing the Color Palette
You can change the color of ink in any well of the Palette window by double-clicking on the color in 
the well (unless the Color Locator tool is active).  Each ink well represents an entry in the global color
palette.  Changing the color in any ink well will also change the color of all pixels previously painted 
with ink from that well.

Any ink well may be designated as a transparent color.  Transparency can be used to show through 
the background that the animation is displayed on top of.  Only one ink well may be designated as 
transparent.  To select a different well as transparent, first reset the color in the current transparent 
well to a normal color.

Saving the Color Palette
You can choose to save the current palette to a palette (*.pal) file at any time by selecting the 
Palette.Save command.  Later, you can use the Palette.Open command and select the palette file 
you just saved in the event that you would like to create more animations using the same set of 
colors.

Saving to the special palette file "muagif.pal" will replace the default colors used by GIFted whenever
the program starts or a new file is opened.



Section #3: GIF File Optimization

One of the goals of the GIF (Graphics Interchange Format) file specification is to allow  image 
information to be stored in a compressed form.  This is extremely beneficial to GIF images and 
animations that are posted on web pages.  The smaller the file size, the quicker the web page will 
download and display to the user.

The GIF file specification, however, only supplies a "toolkit" for producing compact files.  The degree 
to which the overall file size is minimized is completely dependent on the way that the toolkit is used. 
Programs that are able to save single image GIF files are quite common, and the degree of 
compression that they achieve is quite close if not equal.  Utilities that save GIF animations are 
newer, less common, and quite often require the user to take manual actions to achieve any 
reductions in file size.

Microangelo GIFted performs many different optimization techniques automatically. It is able to 
consistently save GIF animations in smaller file sizes than any other utility that we are aware of.

"It's Out of Your Hands, Now"
Microangelo GIFted does not provide any type of interface for the user to crop frames or select their 
disposal methods.  It is much easier for GIFted to find the smallest update rectangle and to analyze 
the changes throughout the animation and select the best disposal methods between frames.  Those
are just a few of the steps that are performed to produce an ultra-compact file as a final result.  
Frames are compared pixel by pixel, not just from one frame to the next, but throughout the entire 
animation.  Algorithms determine the best disposal methods to produce the smallest update areas.  
And even when an animation does not define any transparent pixels, GIFted can use transparency 
within each frame's update area to achieve higher levels of compression than that of conventional 
methods.  The result?  The artist is freed from the normal burdens of file optimization and allowed to 
concentrate on the artwork of the animation.  GIFted produces a more efficient and compact file than 
can be achieved by the user – even more compact than other GIF utilities.

How to Optimize
Optimizing GIF files with Microangelo GIFted is easy.  Simply select the "Save Optimized" command 
from the File menu, or select "Save As…" and choose the Optimized GIF option as the File Type.

When to Optimize
GIFted saves GIF animations in full frame by frame format unless directed to perform optimization.  
This method takes much less time than the thorough analysis required for optimization.  We 
recommend using GIFted's special optimization only when necessary to check an animation's size 
during development and as the last step when publishing the animation.


